Typo3 Ver. 4.4— Content Management System Entering & Editing Content

Creighton University Beginning Course

HOW TO USE THIS GUIDE
This guide provides step-by-step instructions for each exercise. Anything that you are supposed to type

or select is noted with various types and colors.

WHEN YOU SEE THIS...
Click Help
Select Show Keys

Type name

Click the Save Icon
Double-Click the activity
Right-Click on the folder
Mark Male

Press <<TAB>>
NOTE:

EX:

TIP:

YOU DO THIS...
Click the left mouse button once on Help from the menu bar.

Click the left mouse button once on the words Show Keys. Select usually
indicates a choice on a sub-menu.

Type the name of the person from the keyboard.

Click the left mouse button once on the icon.

Click the left mouse button twice in rapid succession.

Click the right mouse button once while the folder is highlighted

Click the left mouse button once in the circle to darken it or in the box to
create a checkmark.

Press the Tab Key on the keyboard.
Important information that will assist you in using Outlook.
This indicates there is an example of how you might use the function.

This indicates a shortcut or tip to help you use the tool efficiently.

OVERVIEW — OBJECTIVES

In Typo3 version 4 — Entering and Editing Content, the basics of entering and editing content will be
explored. During the class, you will learn the following:

O O OO0 OO0 0O o o o oo

NOTES:

Introduction to Typo3

Logging into Typo3

Help and resource information

Quick tour of the main menu

Methods of editing

Entering and editing existing content using the View mode
Uploading and inserting files and images

Copying a page and a content element

Moving a page and a content element

Hiding/unhiding a page

Scheduling start and stop dates for pages

Accessing Typo3 off campus

Additional Information: Using the Quick Edit Mode in the Page mode

Creating a new page
Inserting a YouTube video
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INTRODUCTION

Typo3 is a content management system — a way that users within a department can keep their website
information current. The website is developed by the Creighton University Web Design Team and then
the department’s specific content is maintained and updated by designated people within a department.
It gives the user 100% control of their content.

Of those designated within a department, there are three levels of access permissions for entering
content: content editor, site editor, and site owner.

The site owner for the department is responsible for the content that is written.

LOGGING INTO TYPO3
1. Open your Internet Browser (PCs: Internet Explorer 7 or Firefox; Macs: Firefox or Safari).

2. Type typo3.creighton.edu/typo3 in the address bar.
For the Medical School site, please use the address: medschool.creighton.edu/typos3.

3. Tolog in during this training session:
a. Type train-so in the NetlD field.
b. Type patience-so in the Blue Password field.

You will normally log in by typing in your Net/D in the NetlD field and your Blue password
in the Blue Password field.

NOTE: DO NOT SHARE YOUR PASSWORD WITH ANYONE! If you have work study students
or graduate students working on your site, please contact the Webteam to grant
access specifically for the students.

TYPO3 &

’ TYPO3 Log In for Creighton University TEST

NetlD |

BLUE Password |

4. Click Log In.

5. The main menu of Typo3 will appear.

NOTES:
A7/
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HELP AND RESOURCE INFORMATION
There are several resources available to you if you need help:

e The Web Team:
Phone: 402-280-3663
Email: webteam@creighton.edu

e An Application Trainer:
Phone: 402-280-3688

Resource information:

e BlueTrain tutorials: www.bluetrain.creighton.edu. Search for Typo3.

e Typo3 manual: www.creighton.edu/tm

QUICK TOUR - TYPO3 MAIN MENU

Logout button \

TYPO3 ‘ £ site Owner Trainer (train-so)  Logouwt W W @
¥ WEB. TYPO3 4.4.4
[ Page Web Content Management System
R TYPO3 ¥ TYPO3 CMS ver. 4.4.4. Copyright © 1998-2010 Kasper Skarhej. Extensions are copyright
Bl ust of their respective owners. Go to hitp://typo3.com/ for details. TYPO3 comes with
ABSOLUTELY NO WARRANTY; click for details, This is fres software, and you are welcome to redistribute
Module/menu © o it under certain conditions; click for details. Obstructing the appearance of this notice is prohibited by
law.
items e
# Functions This is a brief description of the available modules: Brief description of the
® web q
~FILE = available modules/menu
[ Page Page content .
L Filelist This module allows you to create and edit webpages, view page hit statistics, items
manage different languages and columns of content per page and access special
¥ USER TOOLS page contents like guestbooks and shopping items.
@ View View page
i Task center Shows the look of the current page and lets you edit the content directly.
(& User settings [E] List List of database-records
The Web>List module provides low level access to records appearing on a page.
@ 1nfo Page related information, eg. hit statistics, change log, record counts
The Web=Info module is focused on statistic information about pages. This
includes statistics of pagehits and a changelog allowing browsing of page history
changes. An overview of the number of records on each page as well as page
settings presented in a classic tree structure is provided.
() Access Page editing permissions
Setting of page permissions is vital for controlling backend user access to pages.
YYou can assign a user and a group as owners of a page and set access
permissions for each.
# Functions  Advanced functions
This module contains general export and import functions in addition to specialised
wizards enabling page sorting and batch creating of pages.
7 File
Filelist Listing of files in the directory
This is the file administration system in TYPO3. It allows you to access the file
mounts of your login. Through this module you can upload, copy, move an delete ~

Note: Once you are editing in the View mode, you will see a second logout button. This will log you
out of the View mode. To log out of the of Typo3 session, use the Logout button on the top.

£, Site Owner Trainer (train-so) Logout »w Be %

ent Elements Eammg o
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Module Selections

Site Editor
* WEB

@ Page
M View
List
@ 1nfo

" Y
| Access

# Functions

T Recycler

¥ FILE
Filelist

—
¥ USER TOOLS
Task center

Sj User settings

—1

Explanation of Module Items:

Editing modes

L Page information [ Page
— Page permissions
— Functions

— Undelete deleted data

— Upload files and images ¥ FILE

Personal Settings

Beginning Course

Tip: You can hide the menu items that
you do not frequently use by clicking

on the arrow.

@& View
List
@ Info

S
=| Access

# Functions

Filelist

¥ USER TOOLS
Task center

E; User settings

Module Mode

Description

Web Module: | Page

Allows you to create and edit web pages in the page content view. More
granular editing. Can create new page elements.

View Shows the current page as it would look like on the web and lets you edit
the content. Can only edit existing content elements.

List Provides low level access to records appearing on a page.

Info Provides statistical information about each page

Access Page editing permissions can be set, if a person has the authority to do so.

Functions Create multiple new pages at once.

Recycler Allows you to select any deleted data and undelete it.

File Module: File

list Upload, copy, move, and delete files and images on the Typo3 server.

User Module: | Task Center

Keep track of daily tasks and workflows in Typo3.

Setup

Customize some general features in Typo3.

NOTES:
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Methods of Editing
There are two basic ways of editing the content in your web site, the Page mode and the View mode.

The differences of what you can do in each mode:

Page Mode View Mode
e Can do more granular editing to the e Can see the page almost as it would

content block appear on the web. It is not completely

WYSIWYG — what you see is what you get.
e Can edit using the QuickEdit mode. You
can see and edit all parts of a content
element at one time.

For this training documentation, we will focus on editing in the View mode.

Each mode has its differences. Please use the mode that is comfortable for you.

ENTERING AND EDITING CONTENT USING THE VIEW MODE
1. To start entering or editing content, click View under the Web Module.

Icons located at the top of the page tree:

EY -
v WEB
& Page . “ | Create New Page —
View € TD TYPO3 Demo Training
e »-[] SANDBOX Creates a brand new page.
Iea o S [ Page for Milana
ey [ Page for Caitlin Filter _
OEnfOEE——— [] Page for Andrew
3 Access ] Page for Joe Finds and highlights page titles based on
. > Page for CIW (copy 4) the criteria entered.
# Functions vD How to Create a New Page
B Reload the tree from the Server — E
¥ FILE @ Page for CIW (copy 6)
Filelist ~{g] Water! Refreshes the page tree.
----- |7 Page for Emmett
vuUserTooL,s % Page for Luz
----- Page for Chris .
Task center -] Page for Emmett (copy 1) Page Tree:
&, User settings | [) Page for Alexis Lists the pagetitles that you have access to.
-] New Page for Emmett

The pagetitles are in order that they appear
in the menu.

2. In the page tree (the middle pane), click on the page title you would like to work on. The parent
page is listed first, with sub pages (children pages) listed below (and indented).

TIP: To keep track of which page you are working on, the selected pagetitle is highlighted and the

text is in bold.

NOTES:
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'g“ | TIP: Hiding & Viewing the
Page
Vs ¥-[] TYPO3 Demo Training Page Tree
ew 9 .
: >L)sansox If you would like more
List [ Pag
© i % Page for Caitlin room to work on your
nre --["] Page for Andrew .
2 Access @ Page for Joe page’ you may hlde the
J# Furctions *% :agetfotr:@“r (coﬁv 4JP page tree by clicking on
- ow o Create a New Fage . .
©.[3 Another new page the arrow in the middle
v FILE :jg P b by the scroll bar.
Filelist -[] Page for Emmett
f .
¥ USER TOOLS E ittt « Click on the arrow
Tasl-c center % Eage ;orirn'.lett (copy 1) again to see the Page
- age ror exis
il User seings ;] New Page for Emmett Tree.

NOTE: The order that the pages are listed in the tree will be the way they are listed in the menu
on the web site.

Structure of a Web Page

On each page, the content is grouped into content blocks. There can be multiple content blocks on one
page. Think of the structure of a page like an outline:

I. Pagetitle (one page on your web site)
A. First Content Block
B. Second Content Block
C. Third Content Block, etc.

You want to group your information into blocks so it makes it easier for you to:
e edit - smaller blocks instead of one long block
e have content headers — they come with each block
e copy or move blocks to either add on to the same page or paste on to another page

After you select the page and it is shown in the right-hand pane, you may then edit the content header
or the content block.

Example of a generic .

» Class Example Page - COPY THIS

Welcome to the Typo3 Class! ¢——————— Content Header

CLASSEXAWFLE PAGE-  You can easily change the formatting of selected textin the document text by choosing a look for the selected text from the
Quick Styles gallery on the Home tab. You can also farmat text direclly by using the other controls on the Home tab. Most
controls offer a choice of using the look from the current theme or using a format that you specify directly

page may look R

COPY THIS
s EMPTY BLANK PAGE - COPY

Flease [eview our new procedures.
Please visit the CNN site for further information

Please visitthe CNN site for further information. Content BIOCk

Email the director.

Please complete the application form today!

EMMETT WWW.Cnn.com
CHRIS edu

EMMETT (COPY 1

(s Hil Welcome to the wonderful Typo3 training! Glad you are here. Please contact the WebTeam for additional information.

EMMETT
Flease see the 2008-2009 tuition and fee schedule. 4_/

NOTES:
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Basic Editing
To edit the content header or the content block, hover over the block to edit. You will see the following:

& Edit ! €9 MNew ' ‘g Hide | M Delete

Welcome to the Typo3 Class!

fou can easily change the formatting of selected text in the document text by choosing a look for the selected text from the
CGluick Styles gallery on the Home tab. You can also format text directly by using the other controls on the Home tab. Most
controls offer a choice of using the look from the current theme or using a format that you specify directly.

Function Description

Edit Edit the content header, the content element, and
the start/stop date for the content block.

New Add a new content header and element after the

currently selected block.
Hide / Show Hide or show the content element on the web site.
Delete Deletes the content element.

1. Select Edit. You will the see the following window:

Edit Content Element

Type:

Text v

Columnns: Inde:x:
Mormal v |
Hide:

r

Header:

Welcome to the Typo3 Class!

Align: Type: Link:

Left © Morrnal v

r

Save & Close

Select a tab at the top to:

Tab Function
General Tab Edit the content header.
Text Tab Edit the content element.

Access Tab Set up a start and stop date for viewing the
content element.

NOTES:
)
I’P /
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The General Tab — Editing the Content Header

Select the General tab.

Type the content header under Header.

Select the alignment of the header (if appropriate).

To insert a date above the header, click the calendar and select a date. The date is in dd/mm/yyyy

format, but will show on your page as mm/dd/yyyy.

5. To save and publish changes, select either the Save button (you will remain on the General Tab)
or select the Save & Close button (The editing window will close and you will return to the page.)

PobhE

Edit Content Element

Type:

Text b

Colurnns: Index:
Maormal % | [+

Hide:

r

Header:

Enter the content header. Welcome ta the Typo3 Class!

Align: Type: Link:

Left ~ MNormal (v

-

Save & Close

The Text Tab - Editing the Content
The content is the body of the message.

1. Hover over the content block that you need to edit.
2. Click Edit. You will see the following screen:

v

Columns: Index:
Mormal »| v
Hide:

r

Header:

Welcomes to the Typo3 Class!

Align: Type: Link:

Left % |Hormal s

r

Save k Close

NOTES:
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3. Select the Text tab. The rich text editor will appear:

Edit Content Element

)
N

Mo block format

B 7 U x %

You can easily change the formatting of selected text in the document text by &
choosing a look for the selected text from the Quick Styles gallery on the Home
tab. ¥ou can also format text directly by using the other controls on the Home
tab. Most controls offer a choice of using the look from the current theme or

using a format that you specify directly,

Please review our new procedures.

Please yisit the CHM site for further information.

4. Complete your edits.

Formatting Options available:
Icon: Description:

Bold

Italicize

Underline

=~ =

=

Subscript

[T

®

Superscript

Justify Left

Justify Center

Justify Right

CTTS

Numbering

.
I

.
I

Bullets

i
"

Shift left

L
]

Shift right

By
[

Special characters

Insert a horizontal line

Insert a link

| il

NOTES:
)
I’P /
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Insert a picture

Bz

Insert a table

4

Find and Replace

<r Toggle between the rich text editor and HTML

[ Remove Formatting

Ep] Copy

& Cut

Fe? Paste

) Undo last action

[ Redo last action

1= Table: toggle borders

_‘] Table: properties (caption and summary)

_:I Table: row properties

’*E- Table: insert row before
}E Table: insert row after

== Table: delete row

i Table: split row (only active if rows were previously merged)
nl!u Table: insert column before

& Table: insert column after

i Table: delete column

iy Table: split column (only active if columns were previously merged)
£z Table: cell properties (normal or header)

j‘ﬂ Table: insert cell before

ﬂﬂ: Table: insert cell after

S Table: delete cell

i Table: split cells (only active if cells were previously merged)
iv| Table: Merge cells

NOTES:

Beginning Course
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While in the rich text editor, you may also use the right-mouse click to see a listing of all of the editing
options:

Edit Content Element

B o =iz s
I Ttalic
U Underlins \
X, Subscript
®E Superzcript
= Justify left matting of s
= center ety by . . .
= sustify right [EE of using To see additional editing options,
v directly. .
i= ordered List hover over the arrows at either the
%E Bulleted List lease see q b ” h h h
] ; top or bottom to scroll through the
[ Frep——— remaining options.
= Horizontal Rule rther inforr
@' Insert link rther infarn
[ Insertimage
] 1Insert Table
}a Find And Replace on fon i
<> Tnggle text mode

Remove FnrmattV
——
Cloze

'y Copy Siﬁ
N —

=
%

The Access Tab — Scheduling a Start and Stop Date for the Content Element

You can set up a specific date to show the content element and to stop showing the content element.
This allows the editor to schedule the timing in advance, so the editor does not need to be there on that
date.

To schedule a start and stop time for the content element:
1. Hover over the content block that you need to edit.
2. Click Edit.

3. Select the Access tab.

Edit Content Element

Selected: Items:

[Z] [Hide at login

[Z] |Show ot any login
_ Usergroups:__

E CGCA
Creightones

|

Save & Close

4. Select the calendar icon next to the Start field to select the starting date you would like the

content element to appear. It will appear as of midnight on the selected date. Date format is
DD/MM/YYY.

NOTES:
)
I’P /
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5. Select the calendar icon next to the Stop field to select the stopping date. You do not
necessarily need a stop date. The content element will stop appearing on the web page as of
midnight on the selected date. You will still be able to view the element within Typo3. Date
format is DD/MM/YYY.

6. Click either Save or Save & Close to save your changes.

Table Options
You may create simple tables on your web page. These tables will not have lines around it. For more
advanced tables, contact the Web Team.

1. Place the cursor where you want the table to appear.

2. Click on Insert a table 1 icon.

3. Select the number of rows, columns, and the header options.

General
Description

Caption:

Rows: |2

Cols: g

Headers: |Haader cells on top hd

\

4. Click OK
5. Click on Toggle borders & to view the lines of the table border.

(s, Cancel

To see the Table Options:
1. Select the table.
2. Right-click on the table to view the Table Options menu. The following menu will appear:

ne  twa| =] Cell Properties k
= Insert call befere

8. Insert call after

Please emai & Delete Cel

[ Merge Cells

Please visit "

coming to th £ Row Propstties
== Inssrt Row Befors

On the Inse

with the ove

tables, heaq =~ Delete Fow

When 4
When you ¢ i Insert Column Before

22 Ingert Row After

oy Insert Calumn After
4" Diefete Colurn
= ] Tsole Propertes
5 Toadle borders
Show secondary Remove the <table> Element

* Insert paragraph before

[ Insert paragraph aiter

NOTES:
2
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Inserting a Link

This process applies to inserting links for the following:
Another page within your web site

A file, such as a Word or pdf document

An external web site

An email address

[ ]
[ ]
[ ]
[ ]

To insert a web link (URL address):

Hover over the content block that you want to place the link.

Click Edit.

In the rich text editor, position the cursor at the appropriate location.

Type the text you would like to appear to represent the link. Example: “visit our website” or
“email (name) for more information”. Avoid using phrases such as “click here.”

5. Highlight the text.

A owbdpE

6. Click the Insert Web Link % icon.

7. Five tabs appear at the top of the opened window (the example below is what you will see when
you select an existing link):

. ; External .
Remove link Page File Ermizil
A T A URL F\
Removes the coding Inserts alinktoa Inserts a link to a Inserts a link to an  Inserts an email
of a web link or page within your document that has  external web site. address link.
email address. Will  web site. been uploaded.

only be able to see if
you click on an
existing link.

8. Select one of the tabs. In this example, you are creating a link to an external web site. Select the
External URL tab.

’__ Insertlink

Page File il NOTE: This example shows only four tabs —

e Page, File, External URL, and Email.

- - You will only see these four tabs when
Open in windsw: [width )| « | Feight you are creating a new link.

Style: sxternal-link-new-window '+ The Remove Link tab does not appear.

Title: Opens external link in new windaw

9. In the field labeled URL: type the URL address of the site to link to.

»

- Insert link

Fage File External URL Ernail

pRL:
e oo

Target: v

Open in window: | width % |« | Height
style: external-link-new-window %

Title:

Opens external link in new window

10. Click Set Link. The link will then appear on the web page.

NOTES:
2
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To check a link, save and close the Edit Content Element window and then click on the link in the
page.

NOTE: If you are wondering which document is linked, you can select the link in the rich text editor
and click on Insert Web Link. When the folder tree appears, you will see a flashing red
arrow next to the selected document.

Folder Tree: Files:

+- b DolT TYPOZ Training |.:Idc:w.s
Elue_hills.jpg

@Elue_hillz_ﬂl.jpg
@Elue_hillz_ﬂljpg
olorMap2004.jpg

’@Excel_-_lntrcdu:ticn_-_Exer:iE o

Removing a Link
If you need to remove a link or change it, it is best to remove the link first:
1. Select the link by highlighting it.
2. Click Insert Link or right-mouse click on the link. Select Modify link.
3. Select the Remove link tab.
4. Insert a new link, if appropriate.

Spell Checking and Composing Content in Word

If you are using Internet Explorer, there is NO spell checker in Typo3. Please proofread your material
carefully! If you are using FireFox, you may use FireFox's internal spell checker.

To help you with spell checking, you want to compose your content in Word, for example. To move the
content from Word into Typo3, complete the following steps:

1. Type your content in Word. NOTE: Type content with no formatting.
2. Cut or copy your content from Word.
3. Open Notepad. To start Notepad:

a. Go to the Start Menu of your computer.

b. Click on All Programs.

c. Select Accessories.

d. Click Notepad. Notepad will then open.

e. Click Paste.
In Notepad, highlight the text, and then either copy or cut the selection.
5. Return to Typo3.
6. At the appropriate location, click Paste Text (you can right-click and select Paste) to insert the
content.
Format the text.
8. Save your changes.

B

~

NOTE: Do NOT copy and paste directly from Word.

NOTES:

7
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UPLOADING AND INSERTING FILES AND IMAGES
You may create links to documents (Word, .pdf files, etc.) or insert images. The process to use and
insert either the documents or images is a three-step process:

1. Prepare your document or picture in its own application (i.e. Word, Adobe Acrobat - PDF, or
photo editing software).

2. Upload the document or image into Typo3.
3. Insert the document or image in your web page.

Preparing Images for Uploading

It is important to optimize your picture(s) for the web. Optimizing will compress the file size of your
picture, so when someone looks at it on your web page, the picture will appear right away. If you do not
optimize, the picture will appear to lad a line or two at a time.

There are some free resources available to optimize your pictures:
e Microsoft Picture Manager — you can find this by:
1. Selecting All Programs in your task bar.
2. Click on Microsoft Office.
3. Select Microsoft Office Tools.
4. Select Microsoft Picture Manager.

e Search for picture optimizer in Google — a list of several free optimizers are available, for
example, Imageoptimizer.net.

Uploading Files and Images in Filelist

1. Select Filelist under the File module.
File

Filelist

From the file tree in the middle of the screen, select the file folder you want to upload to.
3. Left-click on the folder icon. The following menu appears:

N

-} [Cdacs
Fename =]
Upload Filez@j} n
Mew [+]
Info
Copy

Cut

Delete

B ®EHE

n

4. Click Upload Files. You will see the following screen:
Upload files

Mumber of files: |1 ¥

[T Owverwrite existing files

Browse. ..

| Upload files || Cancel |

NOTES:
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5. From the drop-down list, select the number of files you want to upload. You may upload up to 10

files at one time.

Click the Browse . . . button. | ||_Browse... |

7. Find the location of the file or picture that you want to upload. Double-click the file name of the
file or picture you want to upload.

8. If you are uploading a new version of an existing file, make sure to check the box next to

Overwrite existing files Cverwrits =xisting files | This will avoid duplication of existing files.

o

9. When you have selected all the files, click the Upload files button. | Yelo=d files |

TIP: When you are looking at the contents of a folder in the Filelist, you may also upload documents or pictures
=
by clicking on the Upload Files button , located in the bar above the folder contents.

[DoIT TYPO3 Training]: docs/ 10 Files, 270 KB ]
L N o
[111 - 807
[} Word_-_Formatting_-_Lorem_Ipsu... Doc 29-09-09 29 KB RW 12
B Word_-_Formatting_-_Lorem_Ipsu... DocC 15-05-08 29 KB RW L7
G Word_-_Formatting_-_Sample_Doc... DOC 258-09-0% 25 KB RW 13

Creating a New Folder within the Filelist

1. Select Filelist under the File module.

2. From the file tree in the middle of the screen, select the file folder you want to add a new folder to.
You will be adding a subfolder to the selected folder.

3. Left-click on the folder icon. The following menu appears:

E-{fdacs
Fename =]
Upload Files [§ jn
Newr o
Info {b [i]
Copy =
Cut =4
Delete T |y

4. Click New.

New file or folder

Number of folders:
| |

| creaefolders || cancel |

o

From the drop-down list, select the number of folders you want to create.
Type the name of the folder.
7. When completed, click the Create folders button.

o

Tip: Create a Folder Quickly L&
You can also click the icon at the top of the screen, next to the Upload Files button.
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Maintaining and Cleaning the Filelist
It is important to maintain the Filelist by keeping files up-to-date and cleaning out unused documents.

When you upload a document, if it is to replace an existing document, make sure that you check the box
. o ) | overer NI .
next to Overwrite existing files Overwrite existing files

You can also cut or delete documents or pictures. Be cautious, though, if others are using your
document or picture. You can tell if the document is being used elsewhere within Typo3 by looking at
the number in the Ref column within the file folder listing.

Filename Type Date Size rRW Ref REF column:
E3 file_1= 0S-07-07 RV ) )
£ file_z 05-07-07 R Number of times a document is
g Billv_e=l- reoeer i used as a link within the Typo3
31 peme_Docs 0z-08-07 riw web pages.
[E9 older than_Bob_Barker 05-07-07 RV
2BE studic.bmp EMP 09-09-07 S06 K RW 1
B ColorMap2004.ipg JPG 09-09-07 502 K RW 2
B Picture_0S1.ipg JPG 09-09-07 274 K RW\ 12
| Tigersoa.apg JPG  09-09-07 252 K RW\3
o/

If you need to cut a document, cut and paste it to another folder, for example, Delete on MM-DD-YYY. If
someone notices that their link is not working because you moved the document to another folder, then
you can easily move the document back to the original folder.

NOTE: If you delete a document, it is removed from the Typo3 server. There is no automatic “trash
can.”

Inserting Files Within the Content Block

1. Go to the page you want to insert a file.

Hover over the block to edit and click Edit.

Select the Text tab.

At the location of where you want to insert a link to the file, type the text that you want to appear.
Example: “For our brochure”

Highlight the text.

Click on the Insert Link icon 'éu
Select the File tab.
Select the folder that the document is in:

Folder Traa: Files:

pON

N O

=l & DoIT TYPOZ Training Ddc:z
[Jdocs O IﬂE><:ceI_-_I|'|I:rc=t:|uctiv:n_-_Exerciz...
Elgrandrcundz @Pi:ture_DBL.jpg
giTTgEE Word_-_Formatting_-_Lorem_Ipsu...
styles

Word_-_Formatting_-_Sample_Doc...
Edtemplates

Word_-_Farmatting_-_Sample_Doc...

9. Select the file name in the right hand column. The inserted file will now appear as a link.
10. Save your work.

NOTES:
)
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Inserting Images
1. In the Rich Text Editor, place the cursor at the location of where you want the picture.

2. Click on the Insert Image icon @.
3. In the window that appears, two tabs are listed: New Plain Image and Drag ‘n’ Drop.

E\ Insertimage
R A
Mew Plain Image Drag'n'Drop
Folder tree: Images (1):
vl d DoIT TYPO3 Training Criles
‘;‘"DFiIes winter jpg B00xE00 pixels
E""{:‘Joy_s_photos

Y"{:‘docs
(S P17
{8 A_Mew_Folder
- army_poTe

{8 Best_Buddies

Bialagy

{8 CCS1-_service_trips

| Career_Office_pix

-3 Docs_for_april

OIerr_poes

- Event_Fliers

-8 Faculty

‘George_folder Vv

4. Decide which method you want to use to insert the image:

Method: Description:

New Plain Image In the “Plain” mode, you can insert only web image formats (jpg, jpeg,
gif, png) up to 640 x 680 pixels. This method is designed for images
which are already optimized for the web.

Drag ‘n’ Drop Find and click on your image then drag it into the editor in the main
window. This method will allow you to insert pictures that have not
been optimized for the web. Please ensure that the images have been
optimized before using this method.

5. Select the file folder that the image is in.
6. Click on the image file name you want to insert. Do not click the thumbnail picture.
7. The image will be inserted into the rich text editor.
8. Save your work.
NOTES:
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Working with the Images
You may format the pictures and arrange text around it.

1. Right-click the image.
2. Select Modify Image. You will see the following window:

image

Current Irnage Mew Plain Image Drag'n'Drop

width: 200
Height: 252

Border: r

Float: WEL set v
Top padding:

Right padding:

Bottarn padding:

Left padding:

Title:

Alternate text:

Click-enlarge: [~

Update

3. Select the following options for the image:
+ Border — places a border around the picture
+ Text float — moves the picture to the position selected (left/right) and brings any text to the side of the
picture.

4. Click Update when all selections are
made.

COPYING OR MOVING A PAGE

Drag and Drop Method
1. Decide on the page you want to copy.
2. Determine the placement of the copied page.
3. Click and drag the page you want to copy or move to the new location.
4. The following menu will appear:
Move page into
. Move page after [3] .
| Copy page into
Copy page afte

5. Select either Move / Copy page into or Move / Copy page after.

- Move / Copy page into will put the page as a sub page of the selected page.
- Move / Copy page after will put the page directly after the selected page.

NOTES:
2
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Copying Using the Menu-Driven Method
1. Click on the page icon of the page you want to copy.

2. From the pop-up menu, select Copy.
Show
Edit

New

Info

>
Cut {5

More options...
Hide
Visibility settings

XLOE

Edit page properties
Delete
History/Undo

Bl B} &) <@ «

3. Click on the page icon of where you want to put the copied page.

4. From the pop-up menu, select either Paste Into or Paste After.
Show
Edit
New Paste Into will put the page as a sub

page of the selected page.

ey

Info

Copy
Cut

Paste into @
Paste after &
More options...

Hide )
Visibility settings

Paste After will put the page directly
after the selected page.

Edit page properties
Delete
History/Undo

Bl B 5 @ «

5. A dialog box will appear depending on if you selected Paste Into or Paste After.

Paste Into Dialog Box: Paste After Dialog Box:
Microsoft Internet Explorer E| Microsoft Internet Explorer
\__‘{/I Copy Page for DoIT into Page for Jodi? \_‘.:/I Copy Page for DolT to after Geeky Mews?
I OK ] [ Cancel ] [ 0K, ] [ Cancel ]
6. Click OK.

7. If you had selected Paste Into, the copied page will appear as a sub page:

TD Page for Milana

----- &l Page for CIW

T,

NOTES:
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8. If you had selected Paste After, the page will be displayed with “(copy 1)” after it:

I_%Page far DolIT (copy 1) |

Moving Using the Menu-Driven Method
1. Click on the page icon of the page you want moved.
2. Select More Options . . .
3. Select Move Page. You will then see the following screen:

4. Click on an arrow of where you want the page to be moved to.

il
5. To see the change, click Reload the tree from the server ¥ (located at the top of the page
tree).

Rename a Pagetitle

Each page must have its own unique name. To give the copied page a unique name, instead of “Page
name (copy 1),” complete the following:

1. Select the you want to rename.
2. Select the Page Properties at the top of the screen.

{ Page Properties Mew Fage Show Hidden Content Elements

3. Under the General tab, go to the Pagetitle field.

.....

4. Click in the Pagetitle field.
5. Change the title to reflect the new page — this will be the filename (URL) of the page.
6. Click on either the Save button or the Save and Close button to save your changes.

NOTES:
)
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NOTE: When entering a Pagetitle (under the Edit Page Properties option), do not use special
characters (*, &, ?, 1, *, \, “). The special characters will be stripped, except for the

backslash \.

IMPORTANT INFORMATION: The backslash cannot be removed by the program and
will break your web site.

NOTE: Do not have the same name for duplicate pages. Having duplicate names will confuse the
user’s browser.

COPYING AND MOVING A CONTENT ELEMENT
You may copy or move a content element. To do this, you need to switch over to the Page mode of
editing.
Copying a content element

1. Go to the Page mode in the Web module:
¥ WEB
——» [ Page
& View
List
@ Info

:I Access

# Functions

2. Select the page, from the page tree, that you want to copy the element from.
3. Make sure you are in the Columns view.

( Path: /TYPO3 Demao Training/SANDBOX/| ] Page for CJW [39600]
B Pagerontent

[E pefault Text
Default

4. Find the content element that you want to copy. Click the icon =] next to Default Text.

NOTES:
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5. The menu will appear. Select Copy.

Show
Edit
New
Info

——» Copy
Cut {b

Xhes»p

More options...
Hide

Visibility settings
Delete
History/Undo

6. Go to the page that you want to place the element. Locate the content element block that you
want the copied content element to come after.

7. Click the icon next to Default Text. Select Paste After.

Show
Edit

New

Bl Ep @ «

Info

Copy

Cut
———P Paste after

More options...

Hide

Visibility settings

Delete

History/Undo E

8. The following dialog box will appear:

HELHORNR

&1 B | <

Microsoft Internet Explorer

\g/ Copy DoIT Top 10 Projects to after Mext 10 Initiatives (copy 1)?

Ok Cancel

9. Click OK.
10. The element has now been copied onto its new position:

=
El pefault Text
Welcome to the Typo2 Class! (copy 1)
You can easily change the formatting of selected text in the document text by

The Copied element choosing 2 leck for the selected text from the Quick Styles gallery on the Home tab.
. You can also format text directly by using the other controls on the Home tab. Most
IS pIaCEd on the controls offer a choice of using the look from the current theme or using a format
page. that you spacify diractly.
Please review our new procedures.
FPlease visit the CHN site for further information.

ol it bl RTINS W S Uy ik "

11. Edit the content element to reflect the new information.

NOTES:
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Moving a Content Element

If you are moving an element within the same page, you can move it by using the move record
up/down arrow. Hover over the block to see the arrows:

|j Default Text
Date: 02-12-10

Move record up

If you are moving the element to another page:
1. Select the Page mode from the Web module.

2. Select the page that has the content element that you want to move. Make sure you are in the
Columns view.

Click the icon = next to Default Text.

Select Cut.

Go to the page that you want to place this element.

Decide where you want to put the block. It will be pasted after the selected block.
Click the icon next to Default Text.

Select Paste After.

© N o A~®

ADDING AN ADDITIONAL ELEMENT IN THE VIEW MODE

To add a new content element, hover over the content block. You will see New in the menu selections:
T

>
|6) Ed | € New ; Hide | ¥ Delete
1160

Typo3 Ver. 4.4 is Cool!

ou can easily change the formatting of selected text in the documnent text by choosing a look for the selected text from the
Cluick Styles gallery on the Home tab. You can also format text directly by using the other controls on the Home tab. Most
controls offer a choice of using the look from the current theme or using a format that you specify directly.

1. Select New. You will see the same editing window as with an existing content block, but you are
adding a new content header and a content block that will appear after the selected block.
2. Enter the information as appropriate.
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HIDING OR UNHIDING A PAGE

If you need to do extensive editing, you may want to hide the page while you are working on it. When
you are done, unhide the page.

1. Click on the page icon next to the page to hide or unhide. The drop down menu appears:
how
sd\t
New
Info

Copy
Cut

X 5O

Paste into

More options...

Hide

Visibility ' dttings
Edit page properties
Delete

History/Undo

2. Click either Hide or Unhide.

3. To reverse your actions, click on the page icon next to the page to hide or unhide and select either
Hide or Unhide.

Bl e @

SCHEDULING START AND STOP DATES FOR A PAGE
You may schedule when an entire page will display and also schedule a specific date when that page will
no longer be visible on the website.

1. Select the page from the page tree.
2. Select Page Properties from the top portion of the screen:

Hidden Content Elements

4. Click the calendar next to the Start field. Select a date. The page will appear as of midnight on
that date.

NOTES:
)
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Edit Page Properties

e | (WO e

Click the calendar.
Start:
h . /

M
— A Select a date from the calendar.
ogin Mode:

wn etk " The date format is DD/MM/YYYY.

21 22 |23 2§ 2% 27

28 29@

Selected: Ite
Today s

1

=

5. Select the calendar icon by the Stop field. The page will disappear from public view as of
midnight on the date specified.

6. You may also include subpages by checking the box under Include subpages.

7. Click either Save or Save & Close to save your changes.

Access:

ACCESSING TYPO3 OFF CAMPUS

NOTE: If you need to review pages when you are off campus, you need to access Typo3 through the
VPN (Virtual Private Network).

If you do not have the VPN installed on your computer, then go to
http://www.creighton.edu/doit/vpn/index.php to download the VPN software. For additional assistance,
please call the Service Desk at 402-280-1111.

LAUNCHING YOUR WEBSITE

Initial Rollout

If your website is brand new, then it is not “live” (not visible on the internet yet). During this time, you
will be able to enter content in the live workspace. For questions regarding your web site, please consult
your project plan.

NOTE: When all content has been entered, please e-mail the webmaster (webmaster@creighton.edu) to
let the Web Team know that your pages are ready to publish. Testing will be conducted by the
Web Design Team. After the web site is tested, the Web Development Team signs off on it and
the web site will go live in the regular maintenance window of Thursday evenings.

After Your Site is Live

After the initial testing by the Web Development Team, all changes/updates to the website are completed
and published by the content editors, site editors, and/or the site owner for the department.

If you encounter any problems, please contact the Web Team at either webteam@creighton.edu or at
ext. 3663.

NOTES:
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ADDITIONAL INFORMATION

USING THE QUICKEDIT MODE IN THE PAGE MODE
If you would like to be able to edit the content header, content block and page access in a no-nonsense
editor, try the QuickEdit mode in the Page mode.

1. Select the Page mode from the Web module.
2. Select the page you want to edit.
3. From the drop-down list, select QuickEdit.

Columns

Path: /TYPO3 Demo Training_«‘SﬁNDBDI_fD Page for CIW [39600]

Columns
Page information

NORMAL

4. You will then see the following screen:

[ wew ] || quickedit v Fath: [ TYPOS Demo Training/| | Mew Page Lxample [%

Create new Pagecontent on page "New Page Cxample”

Mo block format ¥ilB I U % x;: = iz = 3
E 1= EEiA 0N [ i |

o

Click in the Header field and type the content header.

Scroll down to the Text area and type the content.

7. As you scroll further on the page, you will see where you can schedule start and stop dates for
the content block.

8. To select another content element to edit, select the field to the left of the QuickEdit field and

then click on the content header for that block:

o

w 2 E E R EREE

First Content Header v | QuickEdit v|

[ Edit page properties ]
ent Header” on pa

_ Mormal:__
First Content Header

Countdown to Winter Break Has ...
This is My Second Content Head... W
Here's this new header

Surprised Kitty

_ Lleft:
[MNo title]

OEANET

E

E__i: E“ E E‘lﬂ
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CREATING A NEW PAGE

You can create a brand new page using your current template. If you do need to insert a new page, it is
recommended (and easier) to copy a page and change the content (see page 19 — Copying a Page).

To create a brand new page (instead of copying):
1. Select the first page at the very top of your page tree.
2. Click the Create New Page icon at the top of the page tree:
3. On the right hand side of the screen, you will see a listing of all of your pages with arrows in
between.

New record
(] TYPO3 Deme Training

Select a position for the new page:
| TYPOE Dema Training

7| SANDBOX

| Page for Milana

| Page for Cailin

Page for Andrew

[5] Page for Joe

] Page for CIW (copy 4)

| How to Creste & hew Fage

8] Page for S (cony 6)

& Page for Emmett (cooy 11

'| Page for Alevis

4. Determine where you want the new page and click the arrow in that location.

Select a position for the new page:
yo Not Chang + =L

|e - COPY Tt ‘.[] TYPO3 Demo Training
E - COPY TH o
-] SANDBOX
D
-] Page for Milana
D
-] Page for Caitlin
D
.. Page for Andrew

@j Page for Joe
[8]

Mavigaties title:

1 Pagen NEW

NOTES:
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6. Under the General Tab, type a page title in the Pagetitle field.

NOTE: When entering a Pagetitle (under the Edit Page Properties option), do not use
special characters (*, &, ?, 1, *, \, ). The special characters will be stripped, except for the
backslash \.

IMPORTANT INFORMATION: The backslash cannot be removed by the program and
will break your web site.

7. Click either the Save or the Save and Close icons at the top of the screen.
8. You will now see the new page within the list:

New record

[] New Page Example
Select a position for the new page:

D
7] SANDBOX
D

i-[] Page for Milana
D

[ ] Page for Caitlin
D

i-[] Page for Andrew
D

ol aete—
-['] New Page Example
0

D
-[7] Page for CIW (copy 4)

9. Refresh the page tree.

10. Select the Page mode from the Web module.

11. Select your new page.

12. From the drop-down list, select QuickEdit.

BEE EBEBERE
k.

Path: /TYPO3 Demo Training{SANDBOXfD Page for COW [39600]
QuickEdit

Columns
Page information

=

NORMAL

-

13. You will then see the following screen:

[T MEW ] ~ | [ QuickEdit v| path: /TYPO3 Demo Training/| | New Page Example [

Create new Pagecontent on page "New Page Example”

Type:
[ M
Hide:

r

Header:

=
g
o
a
=
g
3
<
s
~
et
x
%,
11
il
"
i
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14. Click in the Header field and type the content header.
15. Scroll down to the Text area and type the content.

16. Click the Save button Q to save your work.

To add additional content elements, complete the following steps:

1. To add content elements, click the Create New Content Element icon at the top of the
page.

First Content Header || QuickEdi ¥ Fath: /TYP
Edit Pagecontent "First Content Header" on page "My New Page"

Type:
Text ~3

2. Select Regular Text Element.

New content element

1: Select type of content element:

Flease =elect the type of page content you wish to create:

Typical page content

< ® ﬁ Regular text element

\\\ regular text element with r and bodytext fields.

3. Once you have selected Regular Text Element, look at the bottom of the screen. Find the
Normal column.

4. Click on the arrow under your first content header.

2: Select position:

Naow, click the position where you wish to place the element on the

[Z] First Content Header

5. You will then see the following &créen: c-;en:

Fath: /TYPOJ Demo Training/ | New Page Exampls

Create new Pagecontent on page "New Page Example”

Gararsl

Type:
Teat -

Al Typai Links (-

| Pagecontent NEW

6. Select the General tab and type in the content header.
7. Select the Text tab and type the content.

8. When completed, _click either Save or Save and Close at the top of the screen:
) (W

|f-' * n r.-.+:-

You may continue the previous steps to add additional content blocks.
NOTES:
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INSERTING A YOUTUBE VIDEO INTO A TYPO3 PAGE

You may insert the embedded code of a YouTube video into a Typo3 page. To do so, you need to insert
a new content element that is specified for HTML.

Inserting a New HTML Content Element

Go to the Page Mode.

Select the Page that you want to insert the video.

Decide where to put the new content block.

Hover the mouse over the content block that will be before the new inserted block.

Click on the New record after this one icon 2 .
You will see the following screen. Select Plain HTML.

Ne

o0 N

Pagecontent NEW - [FID: 39600] Page for CIW.

General HTML

HTML v
Columns: Index:

Normal (v ¥

r/\
< ¥ [Surprised Kitty] )

¥ Show secondary optians (palettes)

8. Select the HTML Tab.

Pagecontent NEW - [FID. 35600] Page for CIW

¥ Show secondary options (palettes)

9. Paste the embedded code from YouTube.
a. Go to the video in YouTube.

b. By the embed code field, you will see an icon \* . Click on the icon to customize options for
your video.

NOTES:
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c. Customize your options first before you copy the embed code (see note within the options).

URL |http:.-'.-‘-.'r-.'r-.'.'.}':}utu b—E.u:::-m.-‘~'.'E|td1"*‘\.=ElElmhjf{I|| _— Embed code

LN <object width="340" height="285"><paramr{|E* JA%

Click to customize your options.

After naking vour =election, copy
and paxzte the embed code above.
The code changes bazed on your
zelection.

[ Include related videos L NOTE: Make sure the Include related
Show Border videos box is not checked.

[] Enable privacy-enhanced mode [7]

H T e
BT N e

Border colors

<«—— The size of the video as it will
appear on your page.

——— NOTE: Make sure you select one
of the two smallest sizes.

(clo=e)

d. Highlight the embed code and copy it.
e. Return to Typo3.

10. Paste the embed code into the HTML field.

Pagecontent NEW - [FID: 39600] Page for CIW

General i=as T

— |

< "alvays" allovfullscreen="true" width="340" height="285"></embed></object> >
T

—— /‘

< =

[v Showsecondary options (palettes)

11. Save and close your work.

12. To see what the video looks like on your page, go to the View Mode and to the page you inserted
the video.

13. Find the video on your page and play it.

NOTES:
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Here's this new header <

alsdfjdfjldfjas;dfjas; df

(1 Tube}
DI ==

Beginning Course

A content element that is
before the video’s element.

Your new element that
contains the YouTube
embedded code.

Tip: You may want to put some information about the video in the previous block, for example, introducing the
video (because you cannot put text into the HTML element that the video is in).

Tip: If you need to remove the code and replace it with another, you will need to edit the element. Go to the Page

mode and click on the pencil icon c? (edit tool) for the HTML element.

g efault HTML
B

Surprised Kitty
name="movie"name="allowFullScreen"name="allowscrip -
taccess"sre="http//vwwi.youtube.com/ v/ 0BmhjfOrke 88 -
hl=en_USEfs=1Erel=08&colori =0x0066998color2=0x54abd -
cBborder=1"

paN
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